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BBC Worldwide
is one of the
world’s leading
programme
distributors

• • • • •

We represent formats and programmes made by
the BBC, as well as over 250 independent producers,
and have invested more than £1bn in the UK creative
sector since the millennium

A

s a creative, innovative media company, our remit
is to grow the reputation of both our programme
makers and the BBC and deliver strong financial returns.
But we can’t do this alone. While we can offer the
expertise, flexibility, knowledge, quality and strength of
a global corporation, we rely on programme makers like
you to deliver your content how and when we need it.

USING THESE GUIDELINES
• • • • •

This content delivery book has been put together to help
you understand what we need from you, both in terms of
marketing assets and technical delivery specs.
We know how much effort and dedication you put into
creating high-quality programmes. We’re committed to
getting your title the attention it deserves. But for us to
be able to produce high-impact marketing and publicity,
we have to work together.
You must refer to these guidelines as soon as you’re
commissioned and use them like a checklist well before

sending content to us. Some key assets, outlined in
your commission/contractual agreement, can only be
created during production - so time, and budget, must
be put aside from the outset.
To help you, we’ve divided these guidelines into
two sections:

SECTION ONE
Marketing and Publicity Requirements

How you can help your programme stand out
SECTION T WO
Technical Delivery Specifications

All the facts you’ll need for delivering
your programme
Please note that these guidelines are regularly updated
as new technical standards emerge and marketing and
publicity demands change.

CONTE NT DE LIVE RY BOOK

CONTE NT DE LIVE RY BOOK

3. Video

16

3.1 Layout

9.2 Editorial Edits

3.3 Aspect Ratio

10. M
 arketing & Publicity
Photography Guidelines

3.4 Branding
3.5 Clocks

10.2 Practical Considerations

3.7 Credits

10.3 Title Treatments

3.8 Calls to Action
19

4.1 Audio Stems

Section One

Marketing and Publicity Requirements

5.3 Ultra-High-Definition (UHD) Blu-Ray Specification
5.4 Full Technical Specification
5.5 Other Specifications

5.6 File Naming Convention
5.7 Native Frame Rates

5.8 Delivery Mechanisms
5.9 Content Back Up

6. Quality Assessment Review (QAR)

2

Introduction

11

Trade Needs

3

1.

12

Consumer Needs

4

Collaboration

5
5

Photography Checklist

9

1.1 Key Contacts

1.3 Delivery Checklist

2.1 Durations

2.2 Presenter-Led and Presenter-Less
2.3 Music Clearance

2.4 Unique IDs (aka UIDs)
2.5 Running Orders
2.6 Title Changes

2.7 AS-11 / Access to TX
2.8 Edit Decision Lists

2.9 Consumer Products Only Version

6.3 QAR Requirements
6.4 QAR Fixes

Paperwork

29

Ancillary Assets

7.2 Delivery Timings

1.5 Worldwide Edits

2. Versions

6.2 Approved QAR Vendors

7.1

1.4 Content Delivery Timelines

27

6.1 QAR Grading

7.

1.2 Post-Production Schedule

7.3 File Names of Paperwork
14

8. Screening Materials
8.1 Screener Format

8.2 BBC Worldwide Watermark
8.3 BITC

8.4 File Naming

11.3 E
 nglish Closed Caption Files for Ingest
into BBC Worldwide MAM System
11.4 Ancillary Assets

5.2 Ultra-High-Definition (UHD) File Specification

Introduction

Campaign Examples

20

5.1 HD File Specification

Technical Delivery Specifications

Prior to Delivery

11.2 F
 oreign Audio Stems for Ingest into
BBC Worldwide MAM System

4.3 File Names for Audio Stems

Section Two

11. D
 elivery of Foreign
Language Content

11.1 Foreign Version Assets Deliverables

4.2 Audio QC

Contents

32

10.1 Preparing the Paperwork for Photography

3.6 Recaps and Trails

5. File Delivery

31

9.1 Compliance Edits

3.2 Graphic Packages for HD Content

4. Audio

9. Production Recalls

30

35

CONTE NT DE LIVE RY BOOK

Section
One

Marketing and Publicity Requirements

• • • • •

To give our sales teams the best opportunity
to sell your title to international buyers (trade)
and global audiences (consumers) they need
the highest quality marketing assets. In many
cases, we need to start this conversation before
production has commenced.
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Trade Needs
We begin our marketing drive as soon as our
involvement with a programme is confirmed.

Examples of trade use include:
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Consumer Needs
For the global consumer market, we need assets to create bespoke
marketing campaigns and merchandising as well as other print,
filmed and online materials. Our challenge here is to produce strong,
eye-catching images, title graphics and ‘Value Added Materials’ for
a huge variety of executions across multiple platforms.

Footage
We’ll ask for footage in three stages during production
– for pre-markets, markets and final delivery. Given the
timing of these events, this may be required while you’re
still in production, with early footage rushes needed to
produce promos and sizzle reels at appropriate times.

Pre-Markets

Are our first opportunity to discuss your title with
potential buyers and broadcasters. As their name
suggests, these take place ahead of the major trade
festivals and often when you’re still at the early stages
of your shoot. Even though the timing may not be ideal,
we may ask you to provide early assets for promos,
sizzle reels and assemblies, and early release images
for print marketing.

Online Catalogue
Our online catalogue (OLC) is a constantly-updated
resource for buyers and ongoing sales to new markets.
It features full details of your programme, promo clips
and aftersales marketing tools such as downloadable
images and ratings reports.

Trade Festivals
Like MIPCOM, MIPTV and our own Showcase, are busy
places where great content vies for attention. In such
competitive environments, we need to make sure your
content shines through.

Examples of campaign elements:

All VAM material should be delivered to broadcast
standard technical specifications. Post-production
paperwork will need to be supplied. If for technical
reasons, you are unable to deliver to broadcast
standard, an exemption must be applied for in advance
of production. If an exemption is not granted, non
broadcast standard material may be rejected.

On- and Off-Air Campaigns

To drive appointments to view, we need final
footage for promos, trails and reels, as well as press
and communications.
Photography Assets

Social Media

Once a programme has been bought, we supply a set
of key artwork and unit stills for use in public-facing
marketing in specific territories e.g. outdoor and press
advertising. These images are also used for listings and
features as well as website and social media content.

Facebook, Twitter and Instagram help us
engage fans and attract new viewers. Photography
is used strategically to tease content and reward
loyal audiences.

Digital Platforms

Buyers need to know how audiences will connect with
our programmes. They need to be drawn in. Intrigued.
They’re bombarded by images every day so ours have
to stand out.

We supply marketing assets to digital platforms such as
Amazon, Netflix, iTunes and YouTube as well as the BBC
Store and iPlayer. These channels are increasingly asking
for Value Added Materials (see below).

Key Art

Value Added Materials (including EPKs)

We may need to create high resolution, high quality
print materials like stand walling, advertising, posters
etc. in addition to our sales catalogue, small format
promo cards and merchandise. We need a selection
of images, including iconic photography and artwork.

Include behind-the-scenes and props photography,
interviews and exclusive content. It can be used across
different media including on-air, on digital platforms, on
social media, press etc. If this is the case, we’ll let you
know during pre-production so you can plan for this
marketing content from the outset.

Bespoke art maybe required. Some festivals
give distributors the opportunity to create event
experiences and incredible installations that give
buyers the chance to interact with programmes
and be captivated by their content.
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Collaboration
To be able to meet these various demands, our Creative
teams need top quality assets. How many will depend on
the size of your commission and the genre of your title.
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MIPCOM Wall - Large format

We’ll work with you to get the best possible material and,
if appropriate, will arrange a specific briefing process
with you, planning assets from pre-production to wrap.
Over the next few pages we’ll share some case studies
to inspire you.

Campaign
Examples

03

Trade Ad - DPS

What’s the big idea?

We rely more and more on photography to help us create
memorable, arresting, global campaigns. But not just any
photography. Assets need to work across all territories
and touchpoints: on-air, off-air, press, digital and social.

CAS E S T U DY 1

Factual Entertainment: Ice Town
CAS E S T U DY 2

Landmark drama: Sherlock

Straightforward stills and screen grabs can only go so
far. We need every photograph to tell a story. To have an
incisive, strategic concept at its heart.
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Character Posters - Portrait format

CAS E S T U DY 3

Children’s: Hey Duggee

The following examples do just that.

04

Promo Card

5

6

01

Advertising

02

01

Print Media - Large Format - Trade

Marketing Campaigns

02

Promo Card

03

Promo Card

03

04

Character Posters - Portrait Format

Print media - Large format - Trade
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Photography
Checklist
When planning photography, the following
needs to be considered:

8. Formats and Options
Single and group shots

1. S tory

Close-ups and other focal lengths

	What is the creative idea? How can we use
photography to push the concept?

Looking into camera and off camera
Landscape and portrait

2. Photographer

Full-length shots without cropping

	The more we support our photographer, the better
the results will be. Identify the key cast and crew, walk
them round the sets and locations, point out significant
props and scenery etc.

	Allow sufficient clear space around the actor(s)
so we can cut them out if necessary.
	Capture plenty of clean background plates. We can
harness set imagery for use in a variety of ways.

3. E xpression

9. Choice

	Capture actors in character and in the spirit of
performance. We often need them to express
themselves more than they might on film.

	Dynamic, iconic shots. These will be the main
marketing images.

4. Lighting

	Episodic images. There must be photography for
each episode and for all versions being supplied
to BBC Worldwide, including presenter-less. Must
include all main characters and key scenes.

	Dig into the heart of the concept and push the lighting
to bring that to life. Shoot actors in lighting that adds
the most depth to their character.

	Generic images. Must be suitable for international use.

5. Framing

	Behind-the-scenes images showing cast and crew
during filming.

	Use camera position and framing to interpret the
dynamics of the brief.

Non-spoiler images for social media use.

6. Composition

	It may be necessary to consider conceptual images
suitable for international marketing use.

	Capture relationships between characters and the
connections with their environment.

	Graphics sequences that tie into programme titles
are also useful.

7. Movement
	Try capturing events in action or creating situations
that convey movement.

As are, where relevant, archive images.
	For technical specifications, please see Section 10,
page 32.
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Section
Two

Technical Delivery Specifications

CONTE NT DE LIVE RY BOOK

CONTE NT DE LIVE RY BOOK

1. Prior to Delivery
Prior to delivery, please ensure that you’ve read this document, flagging
any queries with the relevant Programme Operations Co-ordinator.

• • • • •

These technical delivery specifications are the
main point of reference for BBC and independent
productions, and must be referred to when submitting
content to us for international distribution.
Whether you’re UK-based or overseas, delivering a
version for international distribution, or a language
version; this document has been created to provide
a single reference guide for technical standards,
to help increase operational efficiency and to best
represent your content to our global audiences.

This guide has multiple sections which outline the
specifications for each type of deliverable including
core master assets, ancillaries and photography, as
well as specific details on file delivery to us.
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1.1 Key Contacts

The standard requirement for all BBC Worldwide
commissioned content is that all content and
associated ancillaries are delivered, in full, to the
agreed contractual delivery date as outlined in your
Distribution Agreement. This is normally 90 days
before first transmission or platform launch date.
Please note that scripts must be delivered to the
same contracted delivery dates as the masters.

Please refer to the material summary page for
BBC Worldwide contacts with regards to asset
deliveries, marketing and photography.
Once you’ve made contact with your co-ordinator,
they’ll assign a Box folder for various assets to be
uploaded to, as outlined in this document.

Failure to deliver to these timescales can expose us to
additional ‘rush’ charges from suppliers and penalties
from customers. Any additional costs directly related to
late delivery will be passed back to the production team.

1.2 Post-Production Schedule

For us to track delivery, we’ll require a copy of your
most recent post production schedule, with delivery
dates to BBC Worldwide included. Please make sure you
distribute updated versions to us as and when available.
This can be uploaded to your programme Box folder.

Where the programme content is defined as
topical or time sensitive, then any deviation from
the standard delivery timelines will be agreed at
the point of commissioning.

1.3 Delivery Checklist

To efficiently manage deliveries into BBC Worldwide,
we require production teams to upload a copy of the
delivery checklist to the programme box folder.

1.4 Content Delivery Timelines

For us to plan effectively and secure the best licensing
deals globally, we need to take delivery of your
programme content far enough ahead of its transmission
or VoD launch date. This is to allow our Sales teams to
begin discussions with clients, and for our Operational
teams to make sure that the content is translated,
subtitled, dubbed etc. for each of the local territories
around the world. This is particularly important for bigger
brands and landmark titles where sales efforts are
focused. This ensures that we can guarantee the agreed
return on our commissioning investment.

12
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2. Versions

For BBC Worldwide invested titles, we require all masters to be delivered
seamless, without advertisement breaks.
We distribute content to linear and non-linear clients, some of whom rely
on commercial funding and, therefore, a cut-down version may be required.
We also have clients who require the original TX version, such as Download
to Own clients, and other public service broadcasters. For this reason, we
may request more than one version of a programme to be delivered.

1.5 Worldwide Edits

BBC Worldwide reserves the right to attend edits for
Worldwide versions, to assist with any queries that may
occur prior to delivery.

Programme Operations Contacts

2.1 Durations

Key Titles
Emma Kemp
Emma.kemp@bbc.com
020 8433 2752

2.2 Presenter-Led and Presenter-Less

If the programme you’re delivering airs on the
BBC (including BBC Three), please refer below to
the most applicable duration for you according
to the investment:

Drama
Laura McManus
Laura.mcmanus@bbc.com
020 8433 1574

For factual programmes, presenters may be used
who are not internationally recognised. We may,
therefore, require a version of this programme with
the presenter removed. This often becomes the 50’
version, however in some cases the presenter may be
retained in the 50’ version and, likewise, the presenter
may be removed from the 60’ version.

For all TX durations commissioned by the BBC,
BBC Worldwide will require a copy of the TX version,
at the duration agreed by the commissioning channel
at the BBC.

Comedy & 3rd Party Channels
Kate Hudson
Kate.hudson@bbc.com
020 8433 3273

Presenter-led and Presenter-less versions will
be discussed at the point of investment with the
BBC Worldwide Content Team. Please refer to your
contract for further details.

With regards to the 60 minute TX version, we may need
a 50-minute cut-down of this programme for clients to
air in a commercial hour. A duration between 48 – 52
minutes is acceptable; however, we recommend that
there is consistency in timings across a series.

NHU & NACA
Rebecca Hyde
Rebecca.hyde@bbc.com
020 8433 2050

In certain cases, BBC Worldwide may accept a
Presenter-light version, but only with express
permission in advance.

If the programme is below or exceeds these timings,
please contact us to seek approval.

2.3 Music Clearance

For all TX durations commissioned by a
commercial broadcaster, BBC Worldwide will
only require the commissioned length. Please
note this must be seamless.

Lifestyle, Children’s & Documentaries
Nicola Kibbler
Nicola.kibbler@bbc.com
020 8433 1058

All masters delivered to us must be fully cleared for
international distribution as per the rights agreed at
the point of investment. If tracks are used that are
uncleared for BBC Worldwide, we will require an
additional master to be delivered with these tracks
replaced. Music clearances must be checked prior
to delivery to BBC Worldwide.

In both cases, BBC Worldwide may invest in a different
content configuration e.g. BBC Worldwide could require
a 2 x 45’ version in addition to a TX 1 x 90’.

Music, Science & History
Vanessa Waters
Vanessa.waters@bbc.com
020 8433 3867

For full music clearance details, please refer to your
Distribution Agreement. If you have any questions
please contact RLBAmuscop@bbc.co.uk.

Please note that co-producers may invest in a different
duration/version, e.g. cut to clock. In these instances,
please refer to the relevant investment documents for
further details.

Arts & Access to TX
Sarah Best
Sarah.best@bbc.com
020 8433 2676
13
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3. Video
3.1 Layout

Where text appears on archive content and cannot be
removed, please notify BBC Worldwide in advance and
ensure the QAR vendor documents the timecodes of this
on the QAR report.

Dual Purpose
Textless
Texted

Text constitutes (but is not limited to):

BBC Worldwide takes delivery of three different
types of content layout:

2.4 Unique IDs (aka UIDs)

2.7 AS-11 / Access to TX

Every master asset delivered to BBC Worldwide is
assigned a UID dependant on version.

Where BBC Worldwide has only invested in Access to
TX rights, we will access the AS-11 digital file via BBC I&A
(Information & Archives). These must be cleared for the
territories in which BBC Worldwide has invested. If assets
are not cleared, a cleared version must be delivered to
the BBC Worldwide digital file spec.

UIDs are made up of a core number and a suffix. Titles
that air on the BBC and UKTV will have UIDs allocated by
the commissioner. Titles that air elsewhere will need to
obtain a UID from BBC Worldwide prior to delivery.

BBC Worldwide requires that all available audio stems are
delivered for the TX version. See section 5.1 for further
details, and refer to the material summary page.

Please contact BBC Worldwide in advance of delivery
to confirm your UID assignments. Please note that your
UID information must be correct and visible on all master
assets and paperwork supplied to BBC Worldwide.

2.8 Edit Decision Lists

2.5 Running Orders

Edit decision lists for the various versions delivered to
BBC Worldwide should be uploaded to the programme
Box folder.

We log all assets by TX order. This ensures that all talent
accounting and payments are processed correctly.
Please confirm your TX order as soon as it is known.

2.9 Consumer Products Only Version

For this reason we request that RX, or production orders,
are not referred to on paperwork or master assets.
Knowing that TX order may sometimes change once
assets have delivered, we also ask that episode numbers
are not used on material delivered to BBC Worldwide.
Instead, use the UID and episode titles (if applicable). If
there’s a strong narrative storyline to the series, then
episode numbers are acceptable.

Where BBC Worldwide has only invested for Consumer
Products rights (including DVD and/or EST), we require
deliverables as per the standard specification for the
cleared TX version. This includes the master, paperwork
and screeners documented later in this delivery book.

Lower Thirds
Captions
Numerals
Subtitles

We require fully texted versions of programmes to
service our clients in English-speaking territories.
For our international clients, textless shots are required
to localise effectively. These should be placed after a
minimum of ten seconds of black level following the main
programme, to and from a cut point to facilitate editing.
Elements should be synchronous with those used in the
actual programme.

Graphic Sequences constitutes (but is not limited to):
Maps
Charts
Graphs

3.2 Graphic Packages for HD Content

Where there are fewer than ten texted sequences in the
body of the programme (excluding opening titles and
closing credits), we will accept a Dual Purpose master.
DUAL PURPOSE MEANS

Clients will want to use all the graphic elements
contained in the original programme to maintain
high production values.

Texted Programme Start
Texted Body
Texted Programme End, then all textless elements,
including titles and credits

Project Specifications

To achieve this, we require elements to be supplied
as follows:
Ideally graphics files should be sent in Adobe After
Effects® format. If you would like to send anything else,
please discuss with your BBC Worldwide co-ordinator.
After Effects® projects must have a resolution of
1920x1080 and a frame rate that matches the frame
rate of the programme. Square pixels must be used
throughout. Projects must have a colour depth of 8
bits per channel using ITU-R709 working space.
Project audio must have a sample rate of 48 KHz.

Where there are more than ten texted sequences in the body of the
programme, we will require both a Texted and Textless version
TEXTED MEANS
Texted Programme Start
Texted Body of Programme
Texted Programme End
Textless opening and closing credits

The project must be created using Adobe After Effects®
CC 2015 or later.

TEXTLESS MEANS

2.6 Title Changes

Textless Programme Start
Textless Body of Programme
Textless Programme End
Texted opening and closing credits, and any texted graphics sequences
(to be used as a point of reference when localising)

Please keep us updated with changes to titles; in some
cases BBC Worldwide may adopt a different title to the
UK TX title.
15

Rendered Output
After Effects® layers within projects must be
split into two groups: editable text layers and
background elements.
16

CONTE NT DE LIVE RY BOOK

Editable Text Layers

The collection process gathers any media elements
imported in the After Effects® project into a ‘Footage’
sub-folder. The collection report generated by After
Effects® must also be included. This report must include
a list of all third-party plug-ins used in the project.
BBC Worldwide will reject graphics masters that have
After Effects® projects without these elements.

Are any text that would ordinarily be expected to change
during international language versioning. Editable text
layers must be maintained as separate layers in the
After Effects® project. Editable text layers may not
have characteristics that are based on After Effects®
‘Expression’ functions.

Fonts

Background Elements

The collection report provided with the project must
list all fonts that were used in the project. Please do not
supply any fonts.

Are the underlying video, banners, and other elements
that make up the backdrop for the editable text. All of
these layers are required for the international language
versioning process.

Non After Effects® Graphics

Two versions of each composition must be held within
the project.

Graphics elements that contain moving video must be
delivered as a single video layer. Multilayer elements
must be flattened into a single layer, excluding any layers
that contain text.

The first version must contain all the components
required to create all the elements within the project.
The second version must contain all background
elements as pre-rendered video layers alongside all
the editable text layers.

Resolution of 1920 x 1080
Field Dominance set to ‘Upper’ for files containing
interlaced video

Please render all back plates, all elements that include
third party plug-ins and any matte layers which would
overlap an editable text layer.

Frame rate that matches the frame rate of the
programme
Apple ProRes HQ® or the QuickTime® Animation codec

Pre-renders must be rendered using either Apple
ProRes HQ® or QuickTime® Animation codecs within
a QuickTime® (.mov) wrapper. Pre-renders may be
rendered as progressive video or as interlaced video with
upper field first dominance.

Files encoded using the Animation codec must have
spatial resolution set to 50
Bit Rate is set automatically as a function of frame size
and frame rate

Pre-renders must be rendered at a resolution of
1920x1080.

The file must have a bit depth of 8-bits

Collecting After Effects® Projects

Alpha Channel: Yes, if available

After Effects® projects must be ‘collected’ and prerendered prior to delivery. All files used in a project must
be consolidated to the delivery directory using the After
Effects® ‘Collect Files’ command. The ‘Reduce Project’
option must be selected.

The file must use the ITU-R709 colour space
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3.3 Aspect Ratios

3.7 Credits

All content must be delivered to BBC Worldwide as
16:9 full frame. If your production is shooting or post
producing in a different aspect ratio, please notify
BBC Worldwide as early as possible. BBC Worldwide
will also require a copy in the original aspect ratio.

BBC Worldwide will accept credits according to the
commissioning broadcaster guidelines.
Any logos used in credits must be uploaded to the
programme Box folder with a screenshot for reference
of how these were used.

3.4 Branding

3.8 Calls to Action

No BBC Worldwide branding is to be inserted prior to
delivery on any master asset. If needed, this will be
inserted by BBC Worldwide upon delivery to end client.

Any calls to action (including, but not limited to: website
addresses, telephone numbers and hashtags) will need
to be removed from BBC Worldwide masters, unless
otherwise agreed.

3.5 Clocks

All content must come with a clock prefacing the
programme. Clocks must carry the correct BBC
Worldwide UID. Files that do not have the correct UID
will be rejected and must be fixed at production’s cost.
Further information about UIDs can be found in section
3.4. In addition, clocks must carry series title, duration,
and whether the file is texted, textless or dual purpose.

3.6 Recaps and Trails

For recaps (previously on) and trails (next time), we
require these as an additional element at the end of
the master, following the textless elements.
Please ensure these are not time specific (e.g. tomorrow,
next week etc.). Please also ensure that there are
textless elements and all the associated audio (including
split track audio) delivered for these, and they are
documented in the script and music cue sheet.
Please flag if there are no recaps and/or trails for
your programme.

Pixel aspect ratio set to 1:1 (square)
QuickTime® (.mov) wrapper

17
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4. Audio

Effects (all effect stems must be fully filled)

5. File Delivery
5.1	HD File Specification
File to start at T/C 09:59:00:00
30” EBU bars and tone and 30” clock (final 3 secs black) to
First frame of programme start at T/C 10:00:00:00
Programme in its entirety, including opening and closing credits
Minimum 10 second gap before additional elements
Minimum 5 seconds black to end of file.

These can be sourced from a Foley session,
library tracks or from the production recordings.
Foley

All channels must be DISCRETE

If Foley has been commissioned, please provide this
as a separate stem.
Narration (Scripted)
For Children’s content, or where a narrator is used as
a story telling device, please split this out from the
dialogue and provide as a separate stem.

4.1 Audio Stems

BBC Worldwide requires comprehensive audio stems
for all content in order to create localised versions and
promotions. All audio stems must be delivered in stereo
and 5.1 (unless otherwise agreed at point of investment).
Please note that it is mandatory for 5.1 audio to be
delivered for all UHD content.

Narration (Non-Scripted)

P R O G R A M M E C O N T E N T L AY O U T

Any narration needs to be split out from the dialogue that
has remained on the mix minus narration. This includes
any off-camera contributors that may have been used as
narrators at specific points in the programme.

We will also require all audio tracks as discrete stems,
and these must be synchronous (e.g. with bars and tone)
to the programme. They will need to be uploaded to the
programme Box folder.

Wild Track (Non-Scripted)
This is to be delivered for the full programme duration.
Must be provided separately to the music (unless it is
commercial music by a recognised artist).

Final Mix
This is as per the programme broadcast, and must be
EBU R128 and ATSC A85 compliant.

Foreign Dialogue
Any overlapping dialogues must be provided separately.
For example, a German client would want to retain the
foreign dialogue, but replace the English with German.

Music and Effects (Scripted)
This will have all discernible dialogue removed, and
must be fully filled, whether by Foley or library tracks.

Laughter

Mix Minus Narration (Non-Scripted)

Must be split out from the dialogue track, where possible.

This is the final mix minus any voiceover added in
post-production.

4.2 Audio QC

Music and Effects (Non-Scripted)

Dialogue (including split out overlapping dialogues)

All audio stems must be compliant to the above and must
go through a full QAR pass with one of our approved
vendors. Audio stem must be QAR’d against the picture.
See QAR section 7.3 for further details. Production
partners will be responsible for any fixes and redeliveries
as required.

This is all programme dialogue excluding narration.
Any foreign dialogue used needs to be split out onto an
additional stem. The same is true of singing. For details
on all three please see below.

For the audio stems please use the following naming
convention:

Due to synchronous dialogue being recorded on location,
effects must be recreated using either Foley or library
tracks. A true M+E must be created in post-production.

4.3 File Names for Audio Stems

UID_CV Code_Series Title_Season Number_Episode
Title (if applicable) _Audio Stem_Frame Rate.mov

Music
Any music used in the programme, whether live or
commercial, must be supplied. Live music (with the
exception of recognised artists) must be free of vocals,
and the singing must be provided separately.

Production will need to request CV codes and UIDs prior
to delivery in order to generate file names. Any files
received with the incorrect CV and UID will be rejected.

VIDEO SOURCE
VIDEO CODEC PROFILE
C O N TA I N E R
STREAM TYPE
F R A M E R AT E
SCAN FL AG
BIT DEPTH
V I D E O B I T R AT E
VIDEO COMPRESSION MODE
C O LO U R S PAC E
P I X E L A S P E C T R AT I O
FRAME STRUCTURE
I N T R A F R A M E D I S TA N C E
A U D I O S O U N D F O R M AT
SAMPLE FREQUENCY
AUDIO BIT DEPTH
AUDIO CODEC
AUDIO COMPRESSION MODE
A U D I O B I T R AT E
EDIT MARKERS
D I S P L AY R E S O L U T I O N
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Configuration Name

QuickTime® Audio Assignment

1

Main Stereo Left

Left

2

Main Stereo Right

Right

3

M&E / Mix Minus Narr
Stereo Left

Left

4

M&E / Mix Minus Narr
Stereo Right

Right

5

Main Front Left

Left

6

Main Front Right

Right

7

Main Centre

Centre

8

Main LFE

LFE Screen

9

Main Surround Left

Left Surround

10

Main Surround Right

Right Surround

Tracks must be laid out sequentially as noted above.
The content of Channels 1 & 2 must be final mix.
Dolby E encoded 5.1 mix and other audio content layouts may be permitted
with prior approval from BBC Worldwide Global Operations.
Audio indicators/tags must match the above configuration.
Audio tracks must be correctly Tagged (e.g. using QuickTime®)
Please refer to section 4.1 for additional stems that need to be supplied.

Singing

Required stems will include (but are not limited to):

Channel

TIMECODE

Digital: HD-SDI
Apple ProRes® 4:2:2 (HQ)
MOV (All files must have .mov file extension)
QuickTime®
50i and a copy in the native frame rate if different to this (23.98PsF, 24PsF, 25PsF, 29.97PsF, 50i,
59.94i permitted)
As per Source. Interlaced OR Progressive. (Mixed material may only be delivered with
prior approval from BBC Worldwide Global Operations. The file must be accompanied by a
comprehensive schedule specifying the timecodes of the relevant sections.)
10-bit
Typically 185Mbps for 50i content (set by relevant encoding profile)*
VBR (Variable Bit Rate)
YUV (YCbCr)
Square
i-Frame Only
1
Stereo and/or 5.1 Surround
48kHz
24-bit, Other bit-depths by prior approval
PCM (Uncompressed) Big Endian or Little Endian
CBR (Constant Bit Rate)
2.3Mb/s per channel pair (24-bit)
In/out Edit markers must be positioned at the beginning of file
Display resolution must match original picture resolution within MOV
As per source (e.g. programme starts at 10:00:00:00). QT T/C Track
*The Apple ProRes® codecs are designed to target the data rates shown. Because most sequences
contain simple frames, actual bit rates are typically 5 to 10 per cent lower than these targets.
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Audio Track Tagging Instructions:
Opening the file in QuickTime Pro®.

Click Window > Show Movie Properties (Figure 1).
Double click the track name field to modify the track
Name labels according to the table above.
On the window that pops up click on the first audio track
then click on ‘Audio Settings’.
On the right, you’ll see a box that says ‘Channel’ and
‘Assignment’. If exported out of FCP as mono tracks
this will be labelled as ‘Mono’. Click on it and you will see
options to change this.
This will need changing according to the audio content
layout table above.
Do this for all audio tracks, close the window down and
hit File > Save.
To check it’s all done correctly click on
Window > Show Movie Inspector. This will show
you the correctly labelled audio channels.
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5.2	Ultra-High-Definition (UHD)
File Specification

Please note all UHD content delivered to BBC Worldwide
must adhere to the UHD frame-size (3840x2160 pixels)
and not that for 4k (4096x2160). All UHD content must
have a High Dynamic Range (HDR) colour-space unless
by prior agreement with BBC Worldwide.
Please ensure that you preserve the HDR picture
information throughout the production and postproduction process. You should shoot using a
compatible file format (e.g. LOG/RAW). The correct
HDR curve should also be loaded in the camera/s.
Post-production processes (e.g. editing, grading, VFX,
etc.) must also preserve the HDR picture information.
BBC Worldwide has adopted the Hybrid Log Gamma
(HLG) standard for HDR as proposed by the BBC.
The cameras used should be checked prior to
production. The European Broadcast Union (EBU)
Recommendation EBU R118 has details of UHD
cameras and acceptable sensor resolutions.
The EBU divides UHD cameras into two tiers:
UHD1 Tier 1 sensor resolution must be 3840 x 2160
in each of R & G & B. Where other sensor matrix
technologies are employed, the actual resolution may
have to be confirmed by measurement (EBU Tech 3335).
As guide, a Bayer pattern sensor would need to be at
least 5760 x 3240 to achieve full UHD1 resolution.
UHD1 Tier 2 sensor resolution must be greater than
2880 x 1620.
The use of UHD-1 Tier 2 cameras requires approval from
BBC Worldwide before they can be used.
Some UHD programmes will contain material from SD
and HD originals and sources which are not considered
to meet UHD broadcast standards. To maintain a high
standard and meet audience expectations, the amount
of non-UHD material is limited to a percentage of the
programme’s total duration.
Non-UHD material must not be used for large
uninterrupted sections of the programme, without
prior approval from BBC Worldwide. This includes
archive material.

Figure 1
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All channels must be DISCRETE

Programmes should conform to the
following quotas:
Drama: 0-5% non-4K or non-UHD material

AUDIO
C O N T E N T L AY O U T

Natural History: 25% non-4K or non-UHD material
(target across a series)
Documentaries: 25% non-4K or non- UHD material
(no or limited use of archive sources)
Documentaries: 35% non-4K or non-UHD material
(significant use of archive sources)

Configuration Name

QuickTime® Audio Assignment

1

Main Stereo Left

Left

2

Main Stereo Right

Right

3

M&E / Mix Minus Narr Stereo Left

Left

4

M&E / Mix Minus Narr Stereo Right

Right

5

Main Front Left

Left

6

Main Front Right

Right

7

Main Centre

Centre

8

Main LFE

LFE Screen

9

Main Surround Left

Left Surround

10

Main Surround Right

Right Surround

Tracks must be laid out sequentially as noted above.
The content of Channels 1 & 2 must be final mix.
Dolby E encoded 5.1 mix and other audio content layouts may be permitted
with prior approval from BBC Worldwide Global Operations.
Audio tracks must be correctly Tagged (e.g. using QuickTime)

Percentages for all other genres and any deviation
requests from the above guide require prior approval
from BBC Worldwide.
This spec will be updated with further guidance
when exact technical specifications for this
standard are agreed.

PROGRAMME
C O N T E N T L AY O U T

Channel

VIDEO AND VIDEO CODEC

Format Standard: ITU-R BT.2100 (3840 x 2160 25P)

HDR Format

Hybrid Log-Gamma

Time-Code

Duration

Picture

Sound

Reference* White

75 IRE (code value 721)

09:59:30:00

20”

DPP UHD Line-up

Line-up tone

Colorimetry

ITU-R BT.2100 (as defined in ITU-R BT.2020)

09:59:50:00

Between 7”00fr and
7”05fr

Ident Clock or Slate

Silence

Colour Space

4:2:2 YCRCB

09:59:57:06 (optional)

2fr

2 Frames peak white

1 Frame tone
(on first video white
frame)

Display Aspect Ratio

16:9

Scanning

Progressive

09:59:57:06

2” 19fr

Black

Silence

Bit Depth

10-bit

10:00:00:00

2Note

Programme

Programme

Pixel Aspect Ratio

Square

End of prog

5”

Freeze or
“living hold”

Fade or cut to silence by
end of prog

Structure

Intra Frame (I-Frame) only

Container

MOV - QuickTime

Additional Elements

Min 10” gap from end
of prog

As required

As required

Format

Apple ProRes 422 (HQ)

End of File

Min 5”

Black

Silence

Bit Rate

700 Mb/s

Encoding Profile

High

Format

Stereo and Surround (5.1)

Content

Main (BBC TX) and International

Sample Frequency

48kHZ

Bit Depth

24-bit

Codec

PCM (Uncompressed)

Compression Mode

CBR

Bit Rate

1.152Mb/s per channel

PROFILE

Notes
1. Reference to the DPP UHD bars at https://www.digitalproductionpartnership.co.uk/downloads/standards/
2. Programmes delivered as multiple files are NOT permitted

AUDIO AND
AUDIO CODEC PROFILE

EDIT MARKERS
D I S P L AY R E S O L U T I O N
TIMECODE

In/out Edit markers must be positioned at the beginning of file
Display resolution must match original picture resolution within MOV
As per programme content layout section (e.g. programme starts at 10:00:00:00).
Must use QT T/C Track
* The term “Reference White” is only used here as guidance for the value of a white caption or graphic.
The wording will be updated as soon as an international term and definition has been agreed
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5.3	Ultra-High-Definition (UHD)
Blu-Ray Specification
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5.4 Full Technical Specification

For full technical details, please refer to sections
2 and 3 of the BBC DPP specification:

UHD CHECKLIST

EXAMPLES

DEFINITION

File Type and Format

16-bit TIFF
RAW (YUV)
DPX

File type and format (video or image sequences) can usually be confirmed by
examining the file name and extension used. Note, however, that the metadata found
internally to the image file (TIFF, DPX) is unreliable and frequently incorrect. Format
should include the bit-depth in each colour channel (such as 8-bit, 10-bit, or 16-bit).

Program FFOP/LFOP

720 - 204318
01:00:00:00 - 03:21:24:06

First Frame of Picture and Last Frame of Picture. Frame number and/or timecode
of the first and last frames not including any pre-roll or post-roll of the master.

Resolution

3840x2160
1920x1080

Width and height of the full picture in pixels.

Colour Space

BT.2020
P3

RGB colour primaries which define chromaticity (CIE xy) of red, green, and blue
channels. One of the standard colour spaces (such as BT.2020, DCI P3, BT.709, or
sRGB) should be specified. (The standard colour spaces define the chromaticity
of colour primaries to be used.)

Transfer Function

PQ (ST 2084)

Non-linear function used to encode light values. Also known as gamma, or
electro-optical transfer function (EOTF). One of the standard transfer functions
(such as PQ, ST 2084, BT.2020, BT.709, or sRGB) should be specified.

Frame Rate

23.976
29.97

Frame rate in frames per second.

5.6 File Naming Convention

Levels

Full
Head

Code value quantization range which defines the black level and white level. Full range
(0 - 100%) is recommended for image sequences. Head range (64 - 940) is assumed for
10-bit raw YUV. Other levels (such as Legal, Limited, SMPTE, Studio...) may be specified
but require clarification of code values for black and white.

UID_CV Code_Series Title_Season Number_Episode
Title (if applicable) _Version_Frame Rate.mov

Green (0.2650,0.6900)
Blue (0.1500,0.0600)
Red (0.6800,0.3200)
D65 (0.3127,0.3290)
4000 nit Max
0.005 nit Min

SMPTE ST 2086 is metadata to specify the colour volume (the colour primaries, white
point, and luminance range) of the display that was used in mastering video content.
Colour primaries G, B, R and the white point may be specified directly in chromaticity
CIE xy, or as a reference to a standard (e.g. P3 for primaries, D65 for white point). Max
and min luminance may be specified in units of nits. These values then need to be
converted into an encoder setting. Refer to the attached ST2086 worksheet for
conversion when the encoder setting (cell G16) is needed.

1977 nit MaxCLL
1112 nit MaxFALL

MaxCLL indicates the maximum light level of pixel, in units of nits (1 cd/m2), in the
entire playback sequence. MaxFALL indicates the maximum value of the frame
average light level, in units of nits (1 cd/m2), in the entire playback sequence.
Note that these are statistically derived values which should be different and
provided for each video content.

SMPTE ST2086
Metadata

CEA MaxCLL and MaxFALL
Metadata

included as the version. Please replace DP with
TD (Texted) or TL (Textless) where applicable.
Therefore, the file name should be as follows:
LLCJ061Y01_SXAS122S_Fawlty_Towers_2_Waldorf_
Salad_DP_25p.mov

http://dpp-assets.s3.amazonaws.com/
wp-content/uploads/specs/bbc/
TechnicalDeliveryStandardsBBC.pdf

5.7 Native Frame Rates

5.5 Other Specifications

If the content has been commissioned in a frame rate
other than 50i, BBC Worldwide will require both the native
frame rate and a 50i version to be delivered. Native frame
rates must be delivered to the above specifications, and
be QAR’d in addition to the 50i version.

If you’re delivering theatric, giant screen (4K) or 3D
content, please contact BBC Worldwide to discuss
technical requirements.
BBC Worldwide is currently in discussions surrounding
the delivery of IMF packages, with a view to potentially
servicing clients via this method. These may be
requested of production in exceptional circumstances
when key co-producers and/or commissioning partners
are involved.

5.8 Delivery Mechanisms

Content will need to be delivered to one of BBC
Worldwide’s digital upload vendors. If your QAR
vendor cannot upload to our digital backbone,
please deliver via Aspera (preferred method) to MX1,
notifying BBC Worldwide when files are being sent.
Delivery via encrypted HDD is also acceptable,
but production partners must supply the HDD,
which BBC Worldwide would retain until the content
has been processed.

Files need to be delivered to the BBC Worldwide
naming convention as outlined below.

In exceptional circumstances, delivery via HDCAM SR
would be allowed, but this must be agreed in advance,
upon which an HDCAM SR specification will be provided.
Please note, production partners will need to cover any
costs incurred to create the required ProRes® file from
this tape.

Please ensure there are no spaces in the filename,
using an underscore where a space is required.
Production will need to request CV codes and UIDs
prior to delivery in order to generate file names. Any
files received with the incorrect CV code and UID will
be rejected. Likewise, the UID in the file name must
correspond with the UID on the clock.

In some cases, where content is flagged as high-risk,
we may require delivery of assets to a specific vendor.
This will be discussed in advance of delivery.

E.g. The UID for Fawlty Towers: Series 2 EP3 is:
LLCJ061Y/01

5.9 Content Back Up

The CV code for Fawlty Towers: Series 2 EP3 is:
SXAS122S

BBC Worldwide do not require content to be provided
on LTOs. It is the responsibility of production partners to
retain a copy of the content in order to fix any technical
issues that may arise in the future.

The series title is Fawlty Towers, the season number is
2, and the episode title is Waldorf Salad. Fawlty Towers
is available as a dual purpose master, so DP must be
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 . Quality
6
Assessment
Review (QAR)
6.1 QAR Grading

6.3 QAR Requirements

All content sent to BBC Worldwide is subject to a
quality assessment review prior to delivery, at the cost
of the production partner. Any programmes failing to
meet the required technical standards, or are found to
be in breach of other layout requirements, will be
referred back to the supplying production partner.
The ITU/CCIR5 point grading system is used to assess
programmes for quality.

Video must be checked for the duration of the
programme, including any elements separate to the
main programme. All audio stems, including those
on the master file, must go through a full QAR pass.
In lieu of a record report, QAR reports must contain
timecoded details of the complete content of the file.

6.4 QAR Fixes

Grade 5 – imperceptible impairment

BBC Worldwide have the option to undertake any fixes
if content is required for TX by any clients within 14 days.
Costs of fixes will be charged back to production.

Grade 4 – perceptible, but not annoying impairment
Grade 3 – slightly annoying impairment
Grade 2 – annoying impairment
Grade 1 – very annoying impairment
Programmes should meet a minimum of grade 4
for sound and vision quality. Grade 3 is a borderline
grading, where there may be valid reasons for technical
exemption. In such cases, details must be referred
back to BBC Worldwide for sign off. Grades 1 and 2 are
automatic fails.
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London

Regions

The Ark
Shelana House
31-32 Eastcastle Street
London
W1W 8DL

Dock 10
MediaCityUK, Blue
Manchester
M50 2HQ
Contact
Emma Fitzgerald
emma.fitzgerald@dock10.co.uk
0161 886 5254

Contact
Tom Impey or Conor O’Reilly
(firstname)@theark.uk.com
0207 383 9200

•••••

•••••

Films at 59 Ltd
59 Cotham Hill
Bristol
BS6 6JR

Deluxe 142
142 Wardour St
London
W1F 8DD

Contact
Phil Mead
pm@filmsat59.com
0117 906 4300

Contact
Andrew Kemp
Andrew.kemp@bydeluxe.com
020 7149 2724

•••••

•••••

Editworks
The Hub
Pacific Quay
Glasgow
G51 1D2

MX1 (previously RRMedia)
Unit 3, Victoria Road Industrial Estate
Victoria Road
London
W3 6UU

Contact
Rebecca Wallace
rebecca.wallace@editworks.co.uk
0141 419 9448

Contact
Ben Kyne or Richard Dinsdale
(firstname.lastname)@mx1.com
020 8357 5400

•••••

•••••

Gorilla TV
GloWorks, Heol Porth Teigr
Cardiff
CF10 4GA

VDMS
316-318 Latimer Road
London
W10 6QN

Contact
Richard Moss
Rich.moss@gorillagroup.tv
0292 039 9800

Contact
Sue McHugh or Vicky Harvey
(initialsurname)@visualdatamedia.com
020 8962 2615 or 020 8962 2616

•••••

•••••
Technicolor
28–32 Lexington Street,
Soho
London
W1F 0LFT

Upon completion, a passed QAR report must be
uploaded to the programme Box folder.

6.2 Approved QAR Vendors

All QARs must be conducted by one of
BBC Worldwide’s approved QAR vendors.
Please see list (right) for contact details.

Contact
Louise Stevenson
Louise.Stevenson@technicolor.com
020 7319 4900

All regional BBC Post Production facilities are also
approved to QAR. Please contact BBCW to discuss
QAR vendors if your production is not based in the UK.

•••••

27

28

CONTE NT DE LIVE RY BOOK

7. Paperwork
7.1 Ancillary Assets

7.2 Delivery Timings

BBC Worldwide will require the below to be uploaded
to the programme Box folder, for all versions:

Full post-production scripts, music cue sheets,
programme as completed forms and all associated
paperwork should be delivered to the contracted
delivery date as outlined in your Distribution
Agreement. Please ensure your script transcriber
is aware of this deadline.

1 x timecoded post-production script to be delivered
as a MS Word® file, complete and accurate to dialogue
and action. Script must include titles and full closing
credits. Captions and subtitles to be highlighted
in bold. Any foreign language dialogue (including
and particularly Latin) must be included in both the
original language and English.

7.3 File Names of Paperwork

For the script, PasC and MCS please use the following
naming convention:

1 x medium episodic synopsis to be delivered in
advance of TX.

UID_CV Code_Series Title_Episode Title Asset Type

1 x programme as completed form (PasC).

All forms should have the correct UID and CV code.
Failure to do so may impact on contributor and music
royalty payments.

1 x music cue sheet (MCS).
For programmes that air on the BBC (including
BBC Three), BBC Worldwide will source the PasC
and MCS from Silvermouse.

Please refrain from putting episode numbers on
paperwork to avoid issues if running order changes
occur. If there is a strong narrative storyline to the series,
then episode numbers are acceptable.

For certain content- including certain Co-Productions
the following may be required. Please check with your
Programme Operations Co-ordinator:
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8. Screening
Materials
BBC Worldwide requires proxy files for internal
screenings, and for distribution to external clients to
secure sales of the content. These will be uploaded to
the programme Box folder and must be representative
of the final texted versions, with one file supplied per
episode for all invested durations. This will be delivered
alongside the master files.

8.3 BITC

8.1 Screener Format

Please use the following file names when uploading
to Box:

BBC Worldwide Consumer Products require
1 x BITC DVD (without the watermark) supplied for
each episode of the invested TX version.

8.4 File Naming

The screener must be from the first frame of the
programme to the last frame, with no clocks or textless
elements present.

UID_CV Code_Series Title_Episode Title_Screener

Technical specification: 1280x720 - 2500 kbps, H.264.
Stereo final mix only.

8.2 BBC Worldwide Watermark

The screener must include a BBC Worldwide watermark
(DOG) throughout. This should appear at the top left of
the picture using the logo that can be downloaded via
Box. Please contact BBC Worldwide for access.

CDSL- Combined Dialogue and Spotting List containing
the final and complete As Broadcast Dialogue List used
for creation of closed captions, SDH and localization
files of the final Picture. This As Broadcast Script will
include transcriptions of all dialogue and on-screen
text from start of picture through completion of picture
(not inclusive of credits including “in” and “out” cut-bycut footage and frames, character dialogue, character
efforts (e.g. “grunts” or “sighs”), transcription of titles
and text on screens and translations of all dialogue
spoken other than English.
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9. Production
Recalls
9.1 Compliance Edits

9.2 Editorial Edits

OFCOM complaints
Music clearances
Archive clearances
Contributor sensitivities
Uncleared telephone numbers

Updating VFX
Visible production kit
Credit changes (contributor misspellings)

Compliance edits are where there may be a serious
implication if BBC Worldwide continues to distribute the
content. These instances include, but are not limited to:

Editorial edits are where there are issues that arise
that production would prefer to fix in order to maintain
production values. Examples may be, but are not
limited to:

In these instances, BBC Worldwide will supply the
new version to new clients moving forward. For existing
clients we will operate under reasonable endeavours to
resupply to those who are already under license.

When these are flagged, BBC Worldwide will work with
production partners to resolve the issue as quickly as
possible; whether this be by delivery of an edited version,
or a fix file. Please note the UID may change, which would
affect clock information and paperwork, that would also
need to be resupplied.
In these instances, please notify BBC Worldwide with full
details of the issue, including timecodes, and who has
actioned the recall.
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10. Marketing
& Publicity
Photography
Guidelines
Clearance, Captions, Contracts
and Compliance and Copyright.

As part of your contract you’ll have been assigned a
budget for marketing assets. We want to help you get the
most out of this budget, however large or small it is, and
ensure time is appropriately allocated, from the outset, to
capture these essential materials.

Contractual Requirements
It’s your responsibility to ensure that all contractual
delivery requirements are met and that your
photographer is briefed accordingly.
We strongly recommend that negotiations begin early
as you’ll need to secure rights and agree costs with
third party copyright owners including commissioning
broadcasters, photographers etc. You’ll need to supply
BBC Worldwide with electronic copies of clearance
documentation and licences.

To make sure any photography supplied is usable,
pay attention to the following:
Clearance
All photography will need to be cleared of any copyright
or artist/contributor restrictions for world distribution
and for the rights outlined in your contract.

Captions

Freelance professional photographers need to sign
contracts assigning copyright either to BBC Studios (for
in-house productions) or to the independent production
company. Should the investments be confirmed
during/after filming, a percentage of BBC Worldwide’s
investment must to be set aside to obtain/clear suitable
publicity photography.

Images need to be fully captioned with identification of
all characters/content featured along with the episode
number. A corresponding typed caption list must also be
supplied electronically. We’ll provide you with a caption
list template and ask you to confirm the rights listed
are correct. Your photographer’s name, any third-party
image credits and rights should also be included.

Before BBC Worldwide can use your images, or supply
them to buyers or broadcasters, we must have written
confirmation from both the executive producer and
the BBC executive producer (where applicable) that
all images and captions comply with the BBC Editorial
Guidelines (http://www.bbc.co.uk/editorialguidelines).

As well as associated programme publicity - including
print, online and product artwork - the photography
should also be cleared for posting on social network
sites such as Facebook and Twitter.
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10.2 Practical considerations

Additional Rights
When BBC Worldwide has acquired pre-cleared
secondary rights eg. DVD, Digital Ownership and
Download to Own, your producer must ensure that your
photography has been fully cleared for these media
across all platforms throughout BBC Worldwide’s
distribution territory. They must also confirm that it is
suitable for product packaging and associated uses
such as product catalogues, posters and point of
sale as well as release to the press. When specified,
photography may need to be cleared for other uses
such as publishing, live events, art works etc. In certain
cases “all media” may be required which will include
merchandising and all ancillary rights.

Timings

Please refer to the dates stipulated in your contract/
distribution agreement.
Quantity
Our requirements vary by genre. Please refer to your
contract/distribution agreement for full details.
Quality
Images should be of the highest technical standard
possible and be “ready for use”, requiring no substantial
post production work – such as cleaning backgrounds
or similar image remedial enhancements. Images are
acceptable at the following minimum specification:

10.1 Preparing the paperwork
for photography

Between 45MB-60MB (4800 pixels on the longest
side), before JPEG compression, for unit photography.
60MB (5600 pixels on the longest side), before JPEG
compression, for specials/iconic photography.

Photography plays an essential role in the promotion
of programmes. So it’s crucial that photographic shoots
are built into your production schedule from day one.
To get the best possible quality, we will need your help
and involvement and the co-operation of your key talent,
right from the outset.

Access to artwork for any designed image, including
the layers and elements.
Access to RAW files.

Talk To Us

CGI images must be high resolution and layered, and,
where applicable, composited with conventional hi-res
stills. Screen grabs of CGI are not acceptable.

To get a clear idea of what’s needed, and how your
shots will be used, we must have a chat early on - with
all interested parties and stakeholders. That includes
BBC Worldwide, BBC Pictures, as well as publicists and
co-producers. When appropriate, we will arrange preproduction meetings and regular picture reviews while
you’re in production.
Write It Down
We’ll supply you with a photography plan
template which must be completed and returned
to us before filming begins. This plan outlines who’s
responsible on your team for making sure suitable
photography is commissioned or acquired, how
you plan to secure the necessary rights and the
tone and scope of the coverage.

Where a Picture Publicist has been engaged to
manage photography assets, it is essential that
they adhere to our guideline document detailing
key deliverables and timings.
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We require title treatments to follow the
below specifications.
Preferably:

Images can be uploaded to BBC Worldwide’s asset
sharing www.box.com. Details will be sent to you directly
by the photo team.

Vector graphics - an Illustrator® or EPS file, with
all fonts outlined.

The on-screen design material i.e. title treatment/logo
should be delivered to wwdigital.artwork.bbc.com

or:
Photoshop® file - either a PSD of TIFF file on a
transparent background. High resolution 300ppi at
as large size as it exists, including all necessary layers
with outlined fonts and effects flattened.

BBC Worldwide
Global Photography
1/C 1, Television Centre
101 Wood Lane
London
W12 7FA

Some Offer Documents will also have a separate
asset list appended to them. This outlines, in detail,
our photography requirements and rights.

Title treatments are required for BBC Worldwide
to create artwork and graphics to promote titles.

Delivery

Or you can post to:

If appropriate we’ll also ask you to provide a detailed
photography brief which captures specific photographic
requirements. We can work with you to put this together.

10.3 Title Treatments

If available:
Horizontal and stacked versions.
Any language versions (sometimes we translate title
treatments for different regions).

Non-Delivery

The font or name of the font of the title treatment.

As photography is a contractual obligation, for which
BBC Worldwide has provided budget, we reserve the
right to reduce our level of investment if the photography
is not available, not sufficient or not useable for technical
or aesthetic reasons. Screen grabs will only be accepted
in addition to the full delivery of the high resolution still
camera photography. Late delivery can delay the final
payment of the investment.

For general enquiries please contact
WWGlobalPhotography@bbc.com

The on-screen design material i.e. title treatment/logo
should be delivered to wwdigital.artwork.bbc.com
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11. Delivery of
Foreign Language
Content
The localisation operations team manage, control and
advise on all matters relating to the commissioning,
delivery and supply of foreign language versions,
ensuring that contractual, technical and quality
thresholds are achieved. This section covers the
minimum acceptable technical standards for delivery of
foreign language content produced by a 3rd party as HD
files and destined to be distributed by BBC Worldwide.

FILE NAMING CONVENTION

Files need to be delivered to the BBC Worldwide naming convention as outlined below.
UID_CV Code_Series Title_Season Number_Episode Title (if applicable)_Version_ Language_
Frame Rate.mov
Please ensure there are no spaces in the filename, using an underscore where a space is required.

P R O G R A M M E C O N T E N T L AY O U T

File to start at T/C 09.59.00.00
30” EBU bars+tone and 30” clock (final 3 secs black) to
First frame of Programme start at T/C 10.00.00.00
Programme in its entirety
Minimum 10 second gap before additional elements
Minimum 30 seconds black to end of file
US Master material may have a different layout (e.g. SMPTE B&T+Picture in@01.00.00.00) – Only by
prior approval from BBC Worldwide Global Operations.
All channels must be DISCRETE

A U D I O C O N T E N T L AY O U T

Version

-F
 ully localised masters where both in vision graphics
and audio are localised in the foreign language. In this
instance, where a dubbing card is included,

For more information on editorial requirements or
delivery of localised assets not listed below, please
contact the Localisation-London Team.

Please ensure that the source content remains
unchanged. Should a Dubbing Card be added, it will be
placed at the end and not change the overall duration
of the programme.

Prior to Delivery
Prior to delivery, please ensure that you have read this
document, flagging any queries with the Localisation
Operations team.

11.1 Foreign Version Assets deliverables
Fully or Partially Localised HD Texted Master File

Contacts

Worldwide will take delivery of fully or partially
localised HD Texted Master File as per the technical
spec outlined in the table below. If HD isn’t available,
the below spec cannot be met or you require further
information of the Delivery mechanisms, please
contact BBC Worldwide to discuss.

Language Operations Team
WWLocalisation-London@bbc.com
Vanessa Lecomte
Vanessa.Lecomte@bbc.com
Senior Localisation Manager

VIDEO SOURCE
VIDEO CODEC PROFILE
C O N TA I N E R
STREAM TYPE
V I D E O F R A M E R AT E
R E S O L U T I O N I N C L U D I N G A S P E C T R AT I O
SCAN FL AG
BIT DEPTH
V I D E O B I T R AT E
VIDEO COMPRESSION MODE
V I D E O C O LO U R S PAC E
P I X E L A S P E C T R AT I O
FRAME STRUCTURE
I N T R A F R A M E D I S TA N C E

MACRO -BLOCK STRUCTURE CHROMA SAMPLING
A U D I O S O U N D F O R M AT

SAMPLE FREQUENCY
AUDIO BIT DEPTH
AUDIO CODEC
AUDIO COMPRESSION MODE
A U D I O B I T R AT E
EDIT MARKERS
D I S P L AY R E S O L U T I O N
TIMECODE
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Configuration Name

QuickTime® Audio Assignment

1

Foreign Main Stereo Left

Left

2

Foreign Main Stereo Right

Right

3

Main (Original Language)
Stereo Left

Left

4

Main (Original Language)
Stereo Right

Right

5

Foreign Main Front Left

Left

6

Foreign Main Front Right

Right

7

Foreign Main Centre

Centre

8

Foreign Main LFE

LFE Screen

9

Foreign Main Surround
Left

Left Surround

10

Foreign Main Surround
Right

Right Surround

11

Foreign

Mono or Discrete-0

12

Foreign Commentary or
Dolby E Ch2

Mono or Discrete-1

Tracks must be laid out sequentially as noted above.
The content of Channels 1 & 2 must be Foreign final mix.
Foreign Dolby E encoded 5.1 mix and other audio content layouts may be permitted
with prior approval from BBC Worldwide Global Operations.
Audio tracks must be correctly Tagged (e.g. using QuickTime Pro) See notes below.

Worldwide take delivery of:
-P
 artially localised masters where the audio is localised
in the foreign language but the video remains as per
source or:

Channel

Digital: HD-SDI
Apple ProRes® 4:2:2 (HQ)
MOV (All files must have .mov file extension)
QuickTime®
As per Source. (23.98PsF, 24PsF, 25PsF, 29.97PsF, 50i, 59.94i permitted)
1920 x 1080
As per Source. Interlaced OR Progressive. (Mixed material may only be delivered with prior approval
from BBC Worldwide Global Operations. The file must be accompanied with a comprehensive
schedule specifying the timecodes of the relevant sections.)
10-bit
Typically 185Mbps for 50i content (set by relevant encoding profile)*
VBR (Variable Bit Rate)
YUV (YCbCr)
Square
I-Frame Only
1
4:2:2 (709)
Stereo and/or 5.1 Surround
48kHz
24-bit, Other bit-depths by prior approval
PCM (Uncompressed) Big Endian or Little Endian
CBR (Constant Bit Rate)
3Mb/s per channel pair (24-bit)
In/out Edit markers must be positioned at the beginning of file.
Display resolution must match original picture resolution within MOV
As per source (e.g. programme starts at 10:00:00:00). QT T/C Track.
*The Apple ProRes® codecs are designed to target the data rates shown. Because most sequences
contain simple frames, actual bit rates are typically 5 to 10 percent lower than these targets.
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Audio Track Tagging Instructions:
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11.2 F
 oreign Audio Stems for Ingest into
BBC Worldwide MAM system

Opening the file in QuickTime Pro®.

BBC Worldwide can take delivery of the foreign audio
stems separate. For more detail on the technical spec,
please contact Localisation-London Operations team.

Click Window > Show Movie Properties (Figure 1).
Double click the track name field to modify the track
Name labels according to the table above.

11.3 E
 nglish Closed Caption Files for Ingest
into BBC Worldwide MAM system

On the window that pops up click on the first audio track
then click on ‘Audio Settings’.

BBC Worldwide can take delivery of English Closed
Caption files if supplied in DFXP format or equivalent.
For more detail on the technical specification, please
contact Localisation-London Operations team.

On the right, you’ll see a box that says ‘Channel’ and
‘Assignment’. If exported out of FCP as mono tracks
this will be labelled as ‘Mono’. Click on it and you will see
options to change this.

11.4 Ancillary Assets

This will need changing according to the audio content
layout table above.

BBC Worldwide will require the below to be
uploaded at the same time as the localised asset
and to the relevant box folder, as communicated
by the Localisation-London Operations team:

Do this for all audio tracks, close the window down and
hit File > Save.
To check it’s all done correctly click on
Window > Show Movie Inspector. This will show
you the correctly labelled audio channels.

Script As Recorded to be delivered as a Word file,
complete and accurate to foreign dialogue and action.
Script must include title translation.
Translated Synopsis and Metadata to be delivered
as a word or excel document.
Glossary to be delivered as a word or excel
document, including the translation of all Key
Names, Terms and Places.

Figure 1
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